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Welcome to your
new Audient iD44
Audio Interface

To help get you started please visit

audient.com/products/iD44
to download the latest software

Features include:
•

4-in, 8-out high performance 			
AD/DA converters

and firmware.
•

4 x Class-A Audient Console Mic

The 12VDC power supply comes

Preamplifiers & 2 x discrete JFET

with interchangeable UK, EU, US

instrument inputs.

and Australian socket adapters and

•

outputs

will work across a broad range of
line voltages making iD44 globally

•

Full Monitor Control Functionality (software
controlled)

portable.

Inside the box:

2 x Independent Class-AB Headphones

•

iD Scroll Control Mode

•

2 x ADAT inputs and 2 x ADAT outputs for
up to 16 channels of Digital I/O

•

iD44

•

Word Clock output

•

12VDC PSU with regional adapters

•

USB2.0 class compliant connectivity with

•

USB Type C Cable

•

USB Type C to Type A Cable

•

Quick Start Guide

integrated Low Latency DSP mixer

iD144 Overview			
Safety Information			
Declaration of Conformities
					
Installation:

Daw Setups:

4
5

44
Pro Tools Setup
45
Logic Pro Setup		
47
Cubase/Nuendo Setup		
49
Ableton Setup

7
8

9
Mac Installation			
12
Windows Installation		
iD App & Firmware Update		 14
		

Hardware Features:
			

Microphone & Line Input		
Instrument Input
Send and Returns
Digital Inputs and Outputs		
Loudspeaker Outputs		
Headphone Outputs
Monitor Control
Metering
Kensington Lock

Troubleshooting & FAQ
Technical Specifications
Dimensions
Warranty & Contact
Service
Glossary

15
16
17
17
19
24
24
25
27
27

Software Features:

28

		
Input Channel Types
Channel Features
Mastering Section Features
System Panel Features
The Routing Matrix
Setting Up Talkback
Save & Loading Presets
Menu & Task Bar Icon
Standalone Mode
Firmware Update
Keyboard Shortcuts

29
31
32
35
37
38
39
40
41
41
42

43

3

50
53
54
55
56
57

iD14 Overview

Safety Information

Channel 1-4 Gain
Controls 0-60dB
Signal and Peak
Indicators

Important Safety Instructions

Encoder

Main Meters

Headphone
Volume
Controls

Please read all of these instructions and save them for later reference before connecting
the DC power adapter to the mains and powering up iD44.
To prevent electrical shock and fire hazard follow all instructions on the 12VDC power supply. iD44
itself does not operate with any high voltage mains supply inside the unit but appropriate safety
measures should still be adhered to regarding the AC/DC supply.

48V Phantom
Power

Assignable
Function
Buttons

100Hz HighPass Filter

Please ensure you only use the supplied iD44 power supply. We cannot recommend the usage of
third party power supplies. In the event of a power supply failure do not open the 12VDC supply. If
required, please contact Audient support so that a suitable replacement can be sourced.

support.audient.com

-10dB Pad

USB Status
LED

iD44 utilises an external switch-mode power supply that is very quiet and rated at 2A. This switchmode design will accept any A.C line voltage from 90v to 264v @ 47-63Hz. Therefore the unit will
work anywhere in the world but please ensure your A.C mains line voltage is within this specification.

Talkback
Cut

Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the power
supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the appropriate international pin

Dim
iD Button

Digital Inputs

adapter is fitted to the power supply before insertion into the mains socket.

Ch2 Insert Send

Line Outputs 1-4

Ch1 Insert Send

WARNING!
To reduce risk of fire or electrical shock,
DO NOT expose this apparatus to rain

Mic/Line
Inputs 1-4

12V DC
Power

or moisture.
No user serviceable parts inside.

Ch2 Insert
Return

World Clock
Output

Please refer servicing to qualified
service personnel.

Ch2 Insert
Return

USB
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Safety Information

Declaration of Conformities

Important Safety Instructions

FCC Part 15B

1. Read these instructions

This apparatus has been tested and found to comply with the limits of a class-A digital device,

2. Keep these instructions

pursuant to Part 15B of the FCC Rules. These limits are designed to provide reasonable protection

3. Heed all warnings

against harmful interference in a residential installation. This equipment generates, uses and can

4. Follow all instructions

radiate radio frequency energy and, if not installed and used in accordance with the instructions,

5. Do not use this equipment near water

may cause harmful interference to radio communications. If this equipment does cause harmful

6. Clean only with dry cloth

interference to radio or television reception, which can be determined by turning the equipment

7. Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment

off and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

(including amplifiers) that produce heat
8. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized
plug has two blades with one wider than the other. A grounding type plug has two blades

1.

Re-orient or relocate the receiving antenna

and a third grounding prong. The wide blade or the third prong are provided for your safety.

2.

Increase the separation between the equipment and receiver

If the provided plug does not fit into your outlet, consult an electrician for replacement of the

3.

Connect the equipment into an outlet on a different circuit from that

		

obsolete outlet
9. Protect power cords from being walked on or pinched particularly at plugs, convenience

4.

to which the receiver is connected
Consult the dealer or an experienced radio/TV technician for help

receptacles, and the point where they exit from the equipment
10. Only use attachments/accessories specified by the manufacturer
11. Unplug this equipment during lightning storms or when unused for long periods of time
12. Refer all servicing to qualified service personnel. Servicing is required when the equipment
has been damaged in any way, such as power supply cord or plug is damaged, liquid has
been spilled or objects have fallen into the equipment, the equipment has been exposed to
rain or moisture, does not operate normally, or has been dropped
13. For products that are a mains powered device: The equipment shall not be exposed to dripping
or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment

		
		
		

We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK,
01256 381944, declare under our sole responsibility that the product iD14
complies with Part 15 of FCC Rules.

		

Operation is subject to the following two conditions:

		
1.
		
2.
			

This device may not cause harmful interference,
This device must accept any interference received,
including interference that may cause undesired operation

We, Audient Ltd, declare that the product, the iD14, to which this declaration
relates, is in material conformity with the appropriate CE standards and
directives for an audio product designed for consumer use.

Audient Ltd has conformed where applicable, to the European Union’s
Directive 2002/95/EC on Restrictions of Hazardous Substances (RoHS) as
well as the following sections of California law which refer to RoHS, namely
sections 25214.10, 25214.10.2, and 58012, Health and Safety Code; Section
42475.2, Public Resources
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MacOS Installation

Installation

Mac Installation
System Requirements
macOS 10.7.5 (Lion) or later
Mac: Inte CPU, 1GB RAM Minimum

1. Download the latest iD
Software
Head to our website for the latest version of
our iD Mixer:

audient.com/products/id44

USB - C

Open the downloaded .dmg file. Now, drag
the downloaded app into your application
folder to install it.

2. Connect iD44
Using the USB cable provided, connect
iD14 to your computer’s USB port.

9

Mac Installation

Mac Installation

3. Status LED

Menu/Task Bar Icons
It’s also worth checking Audio MIDI Setup

Once connected to your computer and

(found in Mac HD > Applications > Utilities).

powered on, the green status LED on iD44 will
illuminate.

Window > Show Audio Window

On MacOS, the iD icon appears in the menu

About iD

bar in the top right hand corner of the screen.
This gives you quick access to various functions

Displays information regarding the current

of the iD44.

version of the iD mixer application.

Here you should see iD44 report with 20

Visit iD Knoweldge Base

inputs and 24 outputs. The clock source is
If at any time the status LED turns off during

configured in the iD app. See page 23 for

Opens a browser windows for the Audient

more details.

Helpdesk with helpful articles and FAQ’s.

normal operation please check all connections
Check for Updates

and if further problems develop please
contact Audient support.

The iD app will check with the Audient update

4. Double Checking Connectivity

server for any available firmware updates for
iD44.

Show Mixer
To ensure iD44 has been detected by your
computer and correct clocking sources are

If the mixer window has been hidden, this will

set-up, navigate to:

bring it back to the forefront.

Macintosh HD > Applications >

Quit

System Preferences
Fully closes the iD mixer application.
Check that iD44 is set as your audio device.
It’s recommended to disable system sounds.

Top Tip
Right click on the iD icon in the Dock and select
Keep in Dock to have quick access to the iD mixer
app at all times.
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Windows Installation
Windows System Requirements:
•

Windows 7 or later (32 or 64 bit)

•

Intel Core 2 @ 1.6 GHz, or AMD 		

4. Check Connectivity

equivalent
•

1 GB RAM Minimum

1. Download the iD44 Software
The status LED will become solidly lit as soon
Head to our website for the latest version of

as iD44 has achieved stable communication

our iD Windows Installer:

and should remain solidly lit during operation
of the unit until power down.
For mixing, buffer size of 256 should be

audient.com/products/iD44

2. Connect iD44
Using the USB cable provided, connect
iD44 to your computer’s USB port and connect

To double check the connection, go to PC

perfect. For tracking, experiment with lower

sound settings by following:

buffer size values.

PC Settings > Control Panel > Hardware and

How powerful your computer is, and how

Sound > Sound

processor hungry your project is, will affect
how low you can get the buffer size settings

the iD44’s power supply.

before you get audio instability.

Here you can see whether iD44 is visible to
the PC and you can make it the computers

3. Run iD Mixer Setup

default sound device by pressing ‘Set Default’.

iD Icon

Double click on the installer to run the iD mixer
setup and follow the on-screen instructions.

Once installed, the iD icon can be found in the
Windows system tray (it may be in the hidden

4. Reboot PC

icons area):

Reboot your PC to make sure that all the

•

drivers have been applied.

Double-click to open iD44 mixer window
when iD44 is connected.

•

Right-click to quit or change sample rate
and buffer size.

12
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Hardware Features

iD App & Firmware Update
Launch the iD Mixer Application

Firmware Update

Launch the iD mixer application

When there is a firmware update, you can

by finding it in the following folder:

select ‘From audient.com’ to download the
latest version automatically (or select ‘From

Macintosh HD > Applications > iDStart

file’ to install a local firmware file).

> All Programs > Audient > iD
For more information on the mixer
application feature set, please refer to
page 17 of this manual onwards.

The latest version number will be retrieved
from our servers and will be displayed (as
shown above). Press next to continue with the
firmware update. Press ‘update’ to install it.
Once complete reboot iD44 using the power

Check for Firmware Updates

switch to apply it.

If your computer is connected to the internet,
the iD app will check for firmware updates
whenever a unit is connected. If there is a
firmware update available then the iD app
will notify you.
You can manual check for updates by going
to the Help menu and selecting ‘Check for
Updates’. It will notify you if you’re on the
latest version of firmware.
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Hardware Features

Microphone Preamplifiers
& Line Inputs
iD44 features four classic Audient
microphone preamplifiers. These preamps
are based on designs from Audient’s classic
consoles and are the same that are used

Instrument Input

Headphone Output

iD44 employs 2 discrete Class-A JFET

On Channels 1 and 2, the iD44 features a

instrument (D.I) inputs on channels one and

dedicated insert to allow you to connect

two which are easily accessible on the front

outboard gear to your recording chain;

of the unit.

Just like the work flow you would find on an
Audient console!

across our entire product range.

The JFET circuitry adds a tiny bit of colour and

The design features discrete Class-A circuitry
providing exceedingly low distortion and

warmth to the signal, making it sound great

The two channels feature an impedance

on guitars and basses.

balanced

send

and

an

electronically

balanced return, all before the AD converters.

noise performance. From a sonic point of

Plugging in a TS (tip-sleeve unbalanced)

view, iD44 is fast, open and detailed.
NeutrikTM XLR/TRS Jack combi-connectors

The four microphone
preamplifiers feature:

provide microphone and line inputs. The line
inputs are padded through the microphone
preamplfiiers.

•

60 dB of clean gain

•

48V (±4V) phantom power rated at 14mA/

jack will override the mic signal for that channel

Insert your favourite EQ and compressor into

and turn it into a fully fledged, fantastic

the insert and with the super clean audient

sounding instrument input with access to the

pre-amps, you can build vocal chains that

Pad and High Pass Filters.

will rival the best out there!

Insert Normalling
The Insert send and return jacks are half

channel
•

normalled meaning you don’t need to patch

>2.8kΩ input impedance which provides

the two together when not in use. The internal

a punchy tone from any microphone

signal chain is only broken when a jack is

transducer type
•

Signal and Clip Indicators

•

-10dB Pad

•

100Hz High Pass Filter to remove

plugged into the return. Plugging a jack into
the Insert send will split the signal which can
be useful for parallel processing.

unwanted rumble
Channels 1 and 2 also include an Insert
Send and Return allowing for the use of
outboard equipment while tracking.
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Patching Inserts

Digital Inputs and Outputs

When using 88.2kHz and 96kHz as a sample
rate, you only have access to 8 channels of

To incorporate your favourite processing

iD44 features two optical inputs and two

digital input and 8 channels of digital output

before conversion, simply patch the iD44

optical outputs. These can be set to operate

(due to the ADAT protocol).

insert send into the first piece of gear in your

using optical stereo S/PDIF or 8-channel

processing chain. Then take the output of the

ADAT using the iD mixer application. All i/o will

More information on how the iD mixer is used

last device in the chain and patch this into the

operate at up to 96kHz, with ADAT dropping

to route to the optical outputs can be found on

iD44 insert return.

to 4 channels at sample rates of 88.2kHz or

pages 36-37.

higher.

Word Clock Output
The iD44 also includes a BNC Word Clock

Direct Access to ADC

output which allows you clock multiple digital
devices to the iD44’s master clock and keep

The Insert return connection on the iD44

everything in sync.

is a electronically balanced input stage
that directly drives the analogue to digital

The Word Clock output will send a clock signal

converter for that channel.
As such, this is a great place to input signals
directly to the ADC, bypassing the preamplifiers and minimising any colouration of
the signal.
This makes it useful to patch in external
microphone pre-amplifiers without adding
additional colouration or noise. It is also handy
for using the iD44’s outputs to drive external
effects before returning them into your DAW
using the insert returns.
Please note; the digital calibration level of the
iD44’s ADC is 0dBFS = +18dBu.

18

at the same sample rate (44.1, 48, 88.2 or
Running in S/PDIF mode, the optical i/o

96kHz) that the iD44 is operating at. This will

provides the option to integrate external

occur regardless of whether the iD44 is being

digital outboard, allowing up to 4 channels of

clocked internally or externally.

audio in and out of the iD44 at sample rates
up to 96KHz.

Clocking Configurations

Running in ADAT mode, the optical i/o

When connecting external digital devices

provides a great way to expand to 20 inputs

to the iD44, its important to ensure that all

for recording via an external mic preamp

devices are synchronised.

such as the Audient ASP800.
The ADAT outputs could also be connected
to headphone distribution systems such as a
HearbackTM HUB or to an 8-channel DAC for
summing purposes
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Hardware Features
iD44 as the Master Clock

To ensure this, one device in the setup must
be set as the master clock. The other devices
will then use the master clocks signal to stay

With the iD44 set as the Master Clock the other

in sync. There can only ever be one master

devices in the chain can be clocked by either

clock present in a chain.

the Optical Port or the BNC word clock output.

iD44 with Single BNC Connection

When clocking just one device, clocking via
The master clock signal can be sent either

the optical port would be the simplest option,

via an Optical cable embedded into the

simply connect the TOSlink cable up to the

digital signal data, or through a BNC clock

iD44’s optical output and to the other digital

line cable. Please bear in mind that the clock

devices input.

will only travel in one direction through these
connections, from a devices output to a

Then set the other device to Slave off the

devices input.

iD44’s clock.

Choosing a Master Clock

If you are using multiple devices then it is

75 Ohm Terminated

recommended to use the BNC word clock
In a digital setup, there can be a number

output and then use T-connectors to Daisy

of options when determining which device

Chain the Devices together. It is important to

should be your master clock. Quite often the

note that the final device in the chain should

best device to set as the master is the one that

have its BNC connector terminated with 75

is connected to the computer (where possible)

Ohms to stop reflections of the clock signal.

such as an audio interface. This way, when you

This should be an switch able option on most

open a project in a DAW, the audio interface

devices.

should change to match the project sample

iD44 with Daisychained BNC connection

BNC T Connector

rate, and therefore change the sample rate
of all the slave devices. However this depends
on the devices being used.

75 Ohm Terminated

Optical TOSlink Cable
20

BNC Word Clock Cable
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Hardware Features
iD44 as the Slave

Class A Mic Preamplifer, Inserts, A/D converters and
Optical Input Block Diagram

The iD44 can also act as the slave to an
external master clock via it’s optical inputs.
The BNC connector is an output only.

CH1
Neutrik

In this case, you would simply connect the
optical output of a device to the iD44’s optical

Auto
Sense
Input
Select

+60dB

D.I 1

input. Then, in the iD mixer application, select

ADC
CH2

the optical input you wish to be used as the

Neutrik

clock source. You would also need to set the
inputs to either ADAT or S/PDIF depending on

Insert

Auto
Sense
Input
Select

+60dB

D.I 2

the specification of the external device.

ADC
Insert

More advanced clocking setups for the iD44

USB
OUT

CH3

can be found at:

Neutrik

ADC

+60dB

audient.com/products/iD44

Direct
Monitor
Path
(software
controlled)

CH4
Neutrik

iD44 clocked via the Optical Port

ADC

+60dB

OPTICAL
IN 1

OPTICAL
IN 2

Input Specs
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Microphone Input

DI Input

Insert Return

XLR Combi Female
Pin 1: Chassis Ground Pin
Pin 2:Hot (+ve)
Pin 3: Cold (-ve)
Input Impedance: >3k ohm
Maximum Input Level: +22 dBu

1/4” TS Jack
Tip: Hot (+ve)
Sleeve: Ground
Input Impedance: >1Meg ohm

Line Input

Insert Sends

1/4” TRS Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Input Impedance: >10k ohm
Maximum Input Level: +18 dBu
Digital Reference: 0dBFS = +18dBU

1/4” TRS Combi Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Input Impedance: >10k ohm
Maximum Input Level: +32dBu

1/4” TRS Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Output Impedance: >100 ohm
Maximum Output Level: +22 dBu

23

Optical Inputs
TOSLink Optical Connector
ADAT: 8 channels @ 48kHz
ADAT SMUX: 4 channels @ 96kHz
S/PDIF: 2 Channels @ All sample rates

Line Outputs

Headphone Output

Monitor Control

Monitor Control Features

iD44 has four line outputs, these can be used

iD44 features a two high current headphone

iD44 provides all of the excellent

•

Volume control (perfectly matched)

for connecting monitors on the back panel in

amplifiers which are fed by separate DAC’s

monitor control functionality as found

•

Alt. loudspeaker with programmable level

the form of balanced TRS jack connectors.

and can be accessed from the headphone

on our consoles.

The outputs are impedance balanced using

jack on the front of the unit.

(assignable to an ‘F’ key)
•

DIM with programmable level

the same topology as our flagship console,

As such, it is possible to control main and

•

CUT

the ASP8024.

alternative loudspeaker volumes with a

•

Mono Sum (assignable to an ‘F’ key)

perfectly matched stereo volume control on

•

Polarity reverse (assignable to an ‘F’ key)

The outputs are fed from high quality DACs

the main unit.

(Digital to Analogue Converters) sending

By using polarity reverse and mono sum

clean, linear audio to your speakers, perfect

it is possible to listen in sum or difference

for critical listening.

(mid or side) modes. This provides an
excellent way to check mono compatibility
and to also learn spatial tricks from your
favourite reference material.

These can be used instead of or alongside
speakers to get an idea how your mix
translates to headphones, or to provide artist
headphone mixes
Accompanied by this monitor volume knob
The headphone outputs can comfortably

are permanently assigned hardware DIM

drive a wide range of headphone impedances

& CUT switches. The level of DIM and ALT.

You can use these outputs for more than

meaning that you will get great sounding

loudspeaker trim can be adjusted in the iD

just speakers. If you want to use hardware

audio no matter what model of headphones

mixer application.

outboard equipment, you can send out up to

you have.

four mono, or two stereo signals from these

Alongside these functions, three user

outputs, This is configured in the iD mixer

programmable ‘F’ keys provide access

software.

to several useful monitoring features.

In order to keep your audio noise free,
we would recommend against the use of
unbalanced (TS, RCA.. etc) cables on the line
outputs.

24
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Hardware Features

Hardware Features

iD Button

The

iD

button

ScrollControl

iD44

into

allowing

the

switches
mode,

Talkback

Hardware Metering

Kensington Lock

The iD44 can take a talkback signal from a

The 8-segment hardware meters indicate

For those who work in educational

variety of places. You can assign one of the 4

playback level of the iD mixer app, so it is

establishments or in situations where your

analogue or 16 digital inputs as your talkback

suggested that end users observe their DAW

equipment is public facing and subject

channel. When tallback is activated, signal

metering for input levels.

to possible theft opportunities, we have

from that channel is sent through one of the

provided a Kensington lock hole to enable

Cue mixes to the artist(s).

you to protect your iD44.

encoder to be used as a scrollwheel for
the computer. This gives you the ability to
control plugin parameters and anything else
that is scrollable. This works well for adding

You can source the talkback audio from

automation or setting parameters in a hands-

another audio device connected to your

on way.

computer such as the built-in microphone.
This allows you to free up an input channel on

To use ScrollControl, hover your mouse

your iD44 that would otherwise be taken up,

over whatever you want to control and rotate

great for big sessions.

Status LED

Details on how to set this up can be found in

The status LED indicates connection via

the ‘Software’ section of this manual.

USB to your computer. A solidly lit light means

the encoder.

ScrollControl may act slightly different
on different plugins or DAWs depending on

that there is stable communication between

how they have been programmed to work

iD44 and your computer.

with scrolling. If you find it is too sensitive or
not sensitive enough, you can try adjust your
computer scrolling speed.

26
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Software Features

Input Channels - Channel Types
The iD mixer application features three types

Using these three channel types, you can

of input channels:

build up your main monitor mix and up to
four additional cue mixes.

Mic Inputs
These are the inputs where you will see the

Its important to note that the iD mixer

signal from the iD44’s four analogue inputs

application only controls the monitoring
of the iD44. Changes made to the iD mixer

Digital Inputs

application won’t affect the level present in

These are the inputs from the iD’s optical

your DAW or audio software.

inputs. The number of digital inputs present
on the iD mixer application depends on the
digital input type (S/PDIF or ADAT) and the
sample rate being used.

Daw Returns
These are the signals being played back
from your DAW. The iD44 has 8 Daw Return
Channels allowing you set up multiple cue
mixes or sends to hardware outboard gear.

29

Software Features

Software Features
Channel Features

Channel Name
Phase Flip

Channel Name

Solo

By double clicking on the name of the channel

The Solo button mutes all other channels

you can rename it to help you organise your iD

other than the one that is currently solo’d.

mixer application. You could name a channel

Multiple channels can be solo’d at one time.

‘Kick’ or ‘Snare’ for example.

Mute

Phase Flip

The Mute button stops this channel from
outputting audio whilst it is engaged.

Inverts the polarity of the signal by 180° to

Pan Control

Stereo Grouping
Solo

Mute

stop phase cancellation. This is useful if you
a micing the rear of a guitar amplifier or the

Fader

underside of a snare drum.

The fader controls the amount of signal that is
sent to currently selected mix. This can be set

Pan Control

to anywhere between -inf dB to +6dB.

Allows you to send the audio to the left, to
the right or anywhere between on your Main

Meter

Monitor Mix or Cue Mixes.

The meter shows the current signal level in
dBFS. Should the signal level exceed 0dBFS

Stereo Grouping

Meters

then the peak indicators will illuminate red to

Allows you to group two adjacent channels

indicate a peak. The peak indicators can be

together into a stereo channel with a single

turned off by clicking in them. You can also

fader controlling the level of both channels.

turn off all peak indicators using

When a channel is stereo grouped, the pans

Alt + Click.

will automatically be set to far left and far
right.

Fader

30
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Software Features
Master Section Features

Channel Features
Mix Selection

Mix Selection

Channel Views

Cue Mix
Name

Mix Solo
Mix Meters

Cue Mix
Level

Clicking on one of mixes allows you to make

This can be great to track down a sudden

changes to that mix. When a mix is selected, it

loud transient on a particular cue mix or to

expands to reveal additional controls for that

monitor the change in level over time as you

mix.

make changes to a mix.

Cue Mix Name

Channel Views

Double clicking on a Cue Mixes name allows

These three buttons allow you control which

you to rename the Cue Mix. If for example you

of the three channel types are shown in the

were creating mixes for four separate band

mixer. If for example you weren’t using the

members, you could name them ‘Drummer’,

digital inputs for a particular project, you can

‘Guitarist’, ‘Bassist’... etc.

simply hide the optical channels by clicking on
the OPT control.

Mix Solo

Chronometer

The Solo button allows you to audition each

Monitor Controls

of the Cue mixes through your monitors.

These six buttons control various aspects of
the iD44’s monitor controller capability. The

Mix level

function of each control can be found below:

The Mix level allows you to control the overall
•

level of the Cue mix that is sent to the outputs.

TB (Talkback)
The talkback button switches talkback

Monitor Controls

Mix Meters

on and off. More information regarding

The Mix meters show the master signal level

talkback and its various settings can be

of the selected Mix.

found in the ‘System Panel’ section of this
manual.

Chronometer

•

ø (Phase Flip)

The Histogram Meters allow you to see not

Pressing this switch flips the phase of

only the current signal level but also the signal

one side of the stereo field. Used in

level from a few seconds previously.

conjunction with the mono button, this
can be a great way to remove centred
elements from a mix. in order to hear the
hidden elements of a mix.
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Mono

Assigning F-Keys

System Panel Features

The mono button sums the stereo outputs
down to mono. This can be used to quickly

Various functions of the iD mixer application

check the mono compatibility of your mix to

can be assigned to the Function Keys of the

make sure it’ll sound great almost anywhere!

iD44 to allow you to quickly control your
monitoring at the click of a button.

Alt
Alt allows you to quickly switch your monitor

To assign a monitor control to an F-Key, simply

path to a secondary set of monitors to

right click on the control and select the F-Key.

let you check how your mix translates on
various speakers.

Digital Input
Format

Output
Routing
Selection

Clock Source
Selection

Routing
Matrix

Mono Mode

You can select which outputs the ALT.
monitor control flips to in the System Panel

Dim Level

Dim

Alt Speaker
Level

Reduces the output level by a pre-set
amount which can be great if you get a call
or need to quickly chat to someone during a

Input
Source

Talkback
Source

session.

Cut
The cut button cuts the signal to the
monitors.
All these controls can be controlled from the
iD44 itself, either by assigning them to an
F-Key, or using the dedicated Dim and Cut
controls.

Talkback
Device
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System Panel Features

Mono Mode

Routing Matrix

your DAW sends out to Outputs 1+2 will
be sent directly to Analogue outputs 1+2.

Digital I/O Format

When the iD44’s Mono feature is engaged
this option controls whether the mono signal

Allows you to select whether each optical

is sent to the left, right or both monitors.

The Routing Matrix allows you to control the

This can also applicable for the digital

audio source for each of the iD44’s outputs

outputs meaning you can have numerous

from the following options:

sends direct from your DAW out via the

input or output uses ADAT or

optical outputs for adding outboard gear

S/PDIF digital format.

Dim Level

Preferred Clock Source

•

When the iD44’s dim button is pressed, this
control defines how much the level is reduced

The Clock source can be selected from either

by.

Alt Speaker Level

clock source can be found in the clocking
section of this manual.

•

•

indicator beside the selector shows the

different speaker brands or types.

current status of the clock on that input.

Output Routing Selection

•

Red - No clock signal detected on input

•

Amber - A clock signal is detected but at

Opens the routing matrix for either the

a different sample rate to iD44

Analogue Outputs, Digital Output 1, Digital

Green - A clock signal is detected and is

Output 2 or the Talkback channel

•

at the correct sample rate.

an example, setting digital outputs 1+2 to

usually used for most standard playback.

DAW THRU would allow you to directly

Alt - This takes signal the Master Mix but

DAW by setting channels in your DAW to

only when the Alt speaker mode is active.

playback via outputs 9+10 (outputs 1-8

Cue A, B , C, D - This takes signal from

Digital outputs 3+4 would be outputs

the four cue mixes which can be created

11+12... and so on.

using the iD mixer. Please note that the

when the iD44 is switched to ALT speaker
mode. This is used to balance levels between

Master Mix of the iD mixer. This is what is

would be your the analogue outputs).

This control defines the level drop/boost

When using an external clock source the

or for extensive fold-back solutions. As

send audio to this output from your

the internal clock or one of the two optical
inputs. More information about choosing a

Main Mix - This takes signal from the

hardware volume control does not affect

Please note that in DAW THRU, the

these mixes and the Cue’s have seperate

channel in question will bypass any

trims which can be adjusted when the

volume control and audio will be passed

cue mix is selected in the Main Mixer

at full scale. If this output is sent to a set

Window.

of monitors without inline attenuation, this
may be very loud.

•

DAW THRU - This allows you to route to
outputs exactly as they would appear

The only exception to this is the

in your DAW. For example, if you set

headphone outouts where the volume

Analogue out 1+2 to DAW THRU, anything

control will still function.

For an external clock source to be working
correctly you would want the indicator to
be green. If the indicator isn’t green, iD44
will default back to the internal clock until it
detects a valid clock input.
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Talkback Source

Saving & Loading Mixer Presets

The Talkback source allows the talkback input

To allow you to quickly setup your iD mixer

Simply enter the name of your preset and

to be taken from one of the iD44’s internal

during a session you can save and quickly

press save.

inputs or from a device connected to the host

load various presets. This is great if you are

computer (such as a built-in microphone or

moving between recording scenarios quite

It is also possible to export your preset files

USB microphone).

often.

in order to send them to friends or to simply
save them within your DAW session files for

When you select an input as your Talkback

Mixer presets can be saved and loaded in

easy recall later on. To do this, select Export

channel, the channel for this channel in the iD

two ways:

Mixer Configuration at the base of the Save

mixer will be changed to a talkback channel

screen.

which will have a TB button in the centre.

•

Using the File menu and selecting either
Save or Open.

Loading a Mixer Configuration

Using standard keyboard shortcuts :

To load a previously saved preset, select

If using an external device, the talkback signal
will appear on channel DAW 10.

•

File > Open to bring up the Load screen.
Faders will only appear for these channels on

Save: Mac -

the Cue mixes, not on the Main Mix.

Windows Load: Mac -

Talkback Device

Windows -

If an external device is selected then this allows
you to select which connected device is used.

Cmd + S
Ctrl + S
Cmd+ O
Ctrl + O

Saving a Preset
To save a preset, simply setup your mixer the
way that you’d like to save. Then select File >

The previously saved configuration will

Save as explained above. The mixer window

appear in a list. Select the configuration you

should then show the Save dialogue.

wish to use and click Load.
You can also open a mixer configuration
directly from a file by selecting Load From File.
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Menu/Task Bar Icons

Check for Updates

Standalone Operation

Firmware Update

MacOS

The iD app will check with the Audient

When in standalone mode, the iD mixer

Occasionally, Audient will release a firmware

update server for any available firmware

settings are saved onto the iD44 itself so

update for the iD44 in order to address

updates for iD44.

that a mixer setting can be instantly recalled

bugs, improve compatibility and add new

as soon as the iD44 is powered on without

features. Therefore you may wish to check

having to connect the iD44 to a computer.

occasionally for any updates.

On MacOS, the iD icon appears in the
menu bar in the top right hand corner of the

Windows

screen. This gives you quick access to various

This is great for setting up complex tracking

functions of the iD44.
The Windows taskbar Icon has all the options

setups in remote locations.

This can be done by navigating to the Window

of the MacOS menu bar icon but also
includes some Windows Specific options.

menu and selecting Check for Updates.
To setup Standalone mode, first setup the iD
mixer in the way that you wish to be saved

The iD mixer application will then check with

onto your iD44. This includes your digital

our update server if any updates for the iD44

I/O settings, output routings and talkback

are currently available. If there are then you

settings in the System panel.

will prompted to install them onto the iD44.

Now navigate to the Setup menu and select
Store Standalone State. The iD

Quit

Mixers

current configuration will then be saved onto
the iD44 itself, ready to be recalled when the

Fully closes the iD mixer application.

Set Sample Rate

About iD

iD44 is next powered on.

Sets the operating sample rate of iD44. 44.1,

Displays information regarding the current

48, 88.2 and 96kHZ are the four options

version of the iD mixer application.

available.

Visit iD Knowledge Base

Set ASIO Buffer Size

Old image. Might need updating

If you then click next, you’ll be prompted to
stop any playback through the iD44. Click
Update and the update will begin. The iD44

Opens a browser window for the Audient

Sets the buffer size of the iD44 between 16

Helpdesk with helpful articles and FAQ’s.

may turn off a number of times.

and 8192 samples. Higher sizes will take
processing load off your computer but will

Set Clock Source

cause increased latency.

Allows you to quickly adjust the clock source
between the internal and optical clocks
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Keyboard Shortcuts

DAW Setup

Keyboard Shortcut Index
To allow you to find all shortcuts for the mixer
application in one place without having to
go through each page of this manual please
refer to this table:

Location		Mac			Windows		Description
		
Faders		

Alt + Click		

Alt + Click		

Resets fader to unity gain (0 dB)

Pans			

Alt + Click		

Alt + Click		

Resets pan pots to central

									position
Solos			

Cmd + Click		

Ctrl + Click		

Clears all solos if clicking on a solo’d

									channel
									Overrides all other solos (for solo
									exclusive) if clicking on an unsolo’d
									channel
Meters		

Alt + Click		

Alt + Click		

Clicking on peak hold indicator will

									clear all clip indicators
System Panel

Cmd + S		

Ctrl + S		

Save mixer configuration

			

Cmd + O		

Ctrl + 0		

Load mixer configuration

View Modes		

Cmd + 1		

Ctrl + 1			

View Mic/Line Input

			

Cmd + 2		

Ctrl + 2		

View Optical (Digital) Inputs

			

Cmd + 3		

Ctrl + 3		

View DAW Mix Inputs

			

Cmd + 4		

Ctrl + 4		

View System Panel

Please check the iD44 page online at audient.com/products/iD44
for the latest mixer application updates.
More shortcuts may be added without notification.
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Pro Tools Setup

Logic Pro Setup

Need iD44 image

Operation with Pro Tools

Operation with Logic Pro

If you are using the iD mixer to monitor input
signals while recording, be sure to disable

Once iD44 has been successfully installed
following the steps detailed in this manual,
launch Pro Tools and ensure that a new
session is created at the desired sample rate
(if clocking internally) or at the rate of the

Once iD44 has been successfully installed

Logic’s software monitoring to avoid phasing

following the steps detailed after page 6 of

as the same source will be heard twice with

this manual, launch Logic Pro and check the

a short delay between the low latency DSP

following:

signal and the delayed software monitoring
signal.

clock source (if clocking externally).

Logic Pro > Preferences > Audio

Assigning I/O

If using Windows, make sure that you have

I/O Setup

set the correct latency and buffer size settings

All of iD44’s input and output channels will

in the iD app before opening a project.
Changing these settings will result in ProTools

Go to Setup > I/O... to label your inputs and

needing to restart.

outputs and ensure that iD44 is correctly

be available to Logic for routing. There are
a total of 20-inputs and 24-outputs reported
from the driver. You can rename input and

reporting 20-inputs and 24-outputs to and

output channels to whatever you wish using

from Pro Tools. Note that analogue outputs
1-8 are the DAW playback channels in the iD
mixer and can either be routed through the iD
mixer or hard-wired directly from Pro Tools to
the physical outputs.

the I/O label function. This is a great way to
keep things organised.

Ensure that iD44 is selected as the active
audio device and set the buffer size (to affect
system latency). If you are experiencing issues
with playback stability and CPU loading, try
increasing the buffer size. This appears with
“overload” errors and/or pops and clicks and
distortion in the audio.

Playback Engine

Mix > I/O Labels

Go to Setup > Playback Engine... and ensure
that iD44 is set as the active playback
device.

For more Pro Tools information consult your
Avid user manuals & documentation.

44

45

All Images need updating?

Operation with Logic Pro

Macintosh HD > Applications > Utilities
Need better quality image

If you are using an external clock source
(ADAT or S/PDIF) to clock iD44, please ensure
that your Logic Pro project is set to the same

Cubase/Nuendo Setup
Operation with Cubase / Nuendo

sample rate when recording and playingback
in a session, otherwise things may sound a bit

Once iD44 has been successfully installed

sharp or flat!

following the steps detailed after page 6 of
this manual, launch Cubase or Nuendo and

File > Project Settings > Audio

head straight for the Devices menu:
Devices > Device Setup...

Select Audient iD44 in the menu to ensure
that Cubase / Nuendo addresses the iD44
device driver. You will be asked if this is OK,
select ‘switch’.

If you are using the internal clock in iD44,

Select Audient iD44 in the devices menu...

setting the sample rate via Logic Pro will

Here you will see the main iD44 information,
where clock sources can be set as well as
activating i/o ports. Be sure to click Externally
Clocked if clocking from another digital device
via ADAT or SPDIF.

update the iD44 sample rate to follow your
session.

Select VST Audio System from the list of options

There may be a slight pause as the system
re-clocks. This is normal.
For more Logic Pro information please

This can be verified in Audio MIDI Setup.

consult your Apple user manuals &
documentation.
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Ableton Live Setup

Cubase/Nuendo Setup
Operation with Cubase / Nuendo

Close the VST device setup panel and
navigate to the VST connections panel:

Buffer sizes can be set in the control panel
Devices > VST Connections (F4)

within the VST devices display. It is ideal to
keep them quite high to reduce CPU loading

Operation with Ableton Live

In the Live Audio Preference panel you can
set an appropriate buffer size (this can be

Once iD44 has been successfully installed

kept high if you are monitoring input signals

following the steps detailed after page 6 of

for recording via the iD mixer. Ensure that

this manual, launch Ableton Live and head

iD44 reports as a 20-in, 24-out device to Live.

straight to:

if you use the iD mixer as the input monitoring

If necessary you can limit the number of

device while recording.

i/o channels reported as active inputs (from

Live > Preferences > Audio

the driver) in Live by using the input and
output config tabs.
This is an excellent feature to help reduce
CPU loading if all channels are not required.

Here you can ensure that all buses have been
created in Cubase / Nuendo and therefore
all ports are addressable in your session. Add

I/O ports can be renamed in the device
panel such that they better represent what
you connect to them (for example Main

new buses and assign them to the necessary

Here navigate to the Audio tab and make sure

i/o if required.

that iD44 is assigned as the playback device.

Monitors, Headphones). This is useful as any
names chosen here will be those displayed
when assigning i/o on track input/output
channel routing.
Bus types can be set (mono / stereo) and
the VST control room section can also be
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used. For more information regarding set-up

For more information about setting up audio

please consult your Steinberg user manuals

i/o refer to your Ableton Live user manuals &

and documentation.

documentation.
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Troubleshooting & FAQ
Troubleshooting

Troubleshooting

Double check that iD44 is set as the active
playback device in your DAW and computer:

“The unit will not power on”

“I have clocking issues which include
iD44 not locking to external ADAT or
SPDIF devices or operating at the
incorrect rate compared to my session”

Double check that an appropriate clock
source is selected (Internal for master
operation), ADAT or S/PDIF clock for
external slave operation. Ensure that you
see the correct sample rate displayed in

System Preferences > Sound > Output Tab
> Audient iD44 (OSX)

Double check that the 12V adaptor is properly

the Format drop-down menu.

If there is an issue with syncing of an external
device, the Status LED in the System Panel

connected and that the regional adaptor
pins of the power supply are fully pushed into

Control Panel > Hardware and Sound >

will be red or yellow. If the status light is red

place.

Sound > Manage Audio Devices > Audient

then iD44 cannot detect a clock signal from an

iD44 (Windows)

external device, and yellow if it can detect a

“I get clicks and pops on DAW
playback”

signal at the wrong sample rate.
Launch the iD mixer application to
activate

communication

between

your

To change sample rate in OSX go to Audio MIDI

This is most likely to do with setting the

computer and iD44. This only needs to be

buffer size too low for your computer. This

done once straight after power up. Once iD44

can be caused by running very large projects

is set to the operational state you desire, you

Macintosh HD > Applications > Utilities > Audio

If you are using Windows, go to the iD

with a lot of plugins and virtual instruments.

can quit the iD application and it will continue

MIDI Setup

icon in the system tray and right click on it.

Experiment with higher buffer sizes. Typically

to function as intended.

you want small buffer sizes for tracking or
recording software synths to keep the latency

In the software mixer, locate the DAW

low. However when mixing it is fine to set a

channels by pressing the DAW view button

slightly higher buffer size as latency is not so

and increase the level of DAW 1+2 fader.

Setup found by navigating to the folder:

This will bring up some settings including
Ensure that Audient iD44 is seen as an audio

sample rate. Alternatively you can alter

device (Window Menu > Show Audio Window).

these settings in the Setup tab of the iD
app.
Change the sample rate to match that of

much of a problem.

the external ADAT device and session.

“When I connect to my computer,
I cannot play any audio out from iD14”
Firstly double check that the USB cable
connecting iD44 to your computer is
functional and attached at both ends.
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Troubleshooting

FAQs

“How do I reset the iD mixer application
to its default state?”

For more information and bug support,

Technical Specifications

please search our online Help Centre which

Microphone Preamplifier:

can be found here:
To reset the mixer application, quit the

(Measurement includes ADC signal path)
MIC GAIN:
LINE GAIN:			
PHANTOM POWER:

support.audient.com

iD app completely, then navigate to the
following folder and delete the state.xml file

MIC EIN
CMRR:
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE (Mic):
INPUT IMPEDANCE (Line):
FREQUENCY RESPONSE:
CROSSTALK:
THD+N @ 0dBu (1kHz):
SNR:
XLR COMBI FEMALE:

For technical support please create

(it will replenish upon a fresh launch of the
application)

a ticket in our online support system,

Macintosh HD > User > Library > Application

of our website (see link above).

0 to +60 dB
-10 to +50 dB
48v +/-4v @ 10mA/Channel
(12VDC only)
-126.0 dBu
>80dB @ 1kHz
+18 dBu (+28dBu with pad)
3k Ω balanced
10k Ω balanced
±0.5 dB 10Hz to 65kHz
<-90 dBu @ 1kHz & 10kHz
<0.003% (-96dBu)
96 dB
Pin 2 (Hot), Pin 3 (Cold) & Pin
1 (Shield)
TIP (Hot), RING (Cold) &
SLEEVE (Shield)

which can also be found in the support section

1/4” TRS JACK:

Support > Audient > iD > state.xml

D.I / Instrument Input:

(C:) > Users > yourusername > AppData >

Headphone Outputs

(Channel 1)

Roaming > Audient > iD > state.xml

D.I MAX GAIN:
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE:
FREQUENCY RESPONSE:
THD+N @ 0dBu (1kHz):
SNR:
1/4” JACK:

Do not delete the parent folder as this will
also contain your iD mixer presets.

“How do I make sure I have the latest
version of iD firmware/software?”

(Measured under AES-17 at phones output)

0 to 60dB
+10 dBu
1MegΩ unbalanced
±0.5 dB 10Hz to 50kHz
<0.3%
95 dB A-weighted
Tip (Hot) & Sleeve (Shield)

Analogue to Digital Converter
(ADC 1 & 2):

MAXIMUM OUTPUT LEVEL:
DIGITAL REFERENCE LEVEL:
OUTPUT IMPEDANCE:
FREQUENCY RESPONSE:
CROSSTALK:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:
MAX LEVEL INTO 30ohms:

+14 dBu (0 dBFS digital maximum)
+14 dBu = 0 dBFS
<50 Ω unbalanced
±0.5dB 10Hz to Fs/2
<-110 dBu @ 1kHz & 10kHz
<0.0008% (-103 dB)
121 dB un-weighted, 124 dB A-weighted
+7.5 dBu 0.003% THD+N Power: 225mW

MAX LEVEL INTO 60ohms:

+10.2 dBu 0.002% THD+N Power: 210mW

MAX LEVEL INTO 600ohms:
1/4” JACK:

+14.2 dBu 0.001% THD+N Power: 54mW
TIP (Hot), RING (Cold) & SLEEVE (Shield)		

(Measured via Insert Returns under AES-17)

To check for the latest updates to the
iD desktop mixer application please visit:

audient.com/products/id44
download and install the latest driver.

MAXIMUM INPUT LEVEL:
DIGITAL REFERENCE LEVEL:
INPUT IMPEDANCE:
FREQUENCY RESPONSE:
CROSSTALK:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:

+18 dBu (0 dBFS digital maximum)
+18 dBu = 0 dBFS
>10k Ω Balanced
±0.5 dB 10Hz to Fs/2 (Nyquist)
-115 dBu @ 1kHz & 10kHz
<0.0008% (-103dB dB
121 dB un-weighted

1/4” TRS JACK:

TIP (Hot), RING (Cold) & SLEEVE
(Shield)

USB 2.0 High Speed
No. of INPUT CHANNELS
No. of OUTPUT CHANNELS
CONNECTOR:
INCLUDED CABLES:

20 (4 Analogue, 16 Digital)
24 (8 Analogue, 16 Digital)
USB Type-C
1.5m USB 2.0 Type-C to
USB Type-C		
1.5m USB 2.0 Type-C to
USB Type-C

DSP Mixer Latency:

ROUND TRIP (in-to-out)
44.1kHz
0.677ms
48.0kHz 0.625ms
88.2kHz 0.354ms
96.0kHz 0.323ms

You will be made aware of firmware releases
from the iD app when connected to the
internet. Please refer to earlier in this user

Digital to Analogue Converter
(DAC 1 & 2):

manual for more information regarding

(Measured under AES-17 at line outputs 1 & 2)

firmware update.

MAXIMUM INPUT LEVEL:
DIGITAL REFERENCE LEVEL:
OUTPUT IMPEDANCE:
FREQUENCY RESPONSE:
CROSSTALK:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:

+18 dBu (0 dBFS digital maximum)
+18 dBu = 0 dBFS
<100 Ω
±0.5 dB 10Hz to Fs/2 (Nyquist)
<-118 dBu @ 1kHz & 10kHz
<0.0006% (-104dB)
124 dB un-weighted, 126 dB
A-weighted

1/4” TRS JACK:

TIP (Hot), RING (Cold) & SLEEVE
(Shield)

52

Digital Input
16-CHANNEL ADAT:
8-CHANNEL ADAT:
STEREO S/PDIF / TOSLINK:
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44.1kHz to 48.0kHz
88.2kHz to 96.0kHz
44.1kHz to 96.0kHz

SMUX
(Stereo)

Dimensions

Warranty
Warranty Statement
Your iD44 comes with a manufacturer’s warranty for one year (12 months) from the
date of despatch to the end user.

174mm

191mm

The warranty covers faults due to defective materials used in manufacture and faulty
workmanship only.
During the warranty period Audient will repair at its discretion or replace the faulty unit
provided it is returned carriage paid to an authorised Audient service centre. We will not
provide warranty repair if in our opinion the fault has resulted from unauthorised modification,
misuse, negligence or accident.
We accept liability to repair or replace your iD44 as described above. We do not accept
any additional liability. This warranty does not affect any legal rights you may have against
the person who supplied this product - it is additional to those rights.

Warranty Limitations
This warranty does not cover damage resulting from accident or misuse. The warranty is void

276mm

unless repairs are carried out by an authorised service centre. The warranty is void if the unit
has been modified other than at the manufacturer’s instruction. The warranty does not cover
components which have a limited life, and which are expected to be periodically replaced for
optimal performance. We do not warrant that the unit shall operate in any other way than as

51mm

69mm

described in this manual.

Audient Ltd
Aspect House
Herriard
Hampshire
RG25 2PN
United Kingdom
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Tel: +44 (0) 1256 381944
audient.com
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Service

Glossary

Service Information

A		 Amperes
ADAT		

Alesis Digital Audio Tape

iD44 contains no user-serviceable components, please refer to qualified service personnel

ADC		

Analogue to Digital Converter

for diagnosis and repair. Your warranty will be void if you tamper with the device at component

DAW		

Digital Audio Workstation

level. If you have any questions with regard to the repair, please contact Audient Ltd.

ASP		

Analogue Signal Processing

CPU		

Central Processing Unit

CUE		

Artist Headphone Mix

DAC		

Digital to Analogue Converter

dB		

Decibel

dBu		

Decibel referenced to 0.775Vrms = 0 dBu

dBFS		

Decibel Full Scale

DC		

Direct Current

D.I		

Direct Injection (Instrument Input)

DoC		

Declaration of Conformity

DSP		

Digital Signal Processing

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or make

EQ		

Equaliser

an enquiry, please visit: support.audient.com

FAQ		

Frequently Asked Questions

FCC		

Federal Communications Commission

GB		

Gigabyte

GUI		

Graphical User Interface

HPF		

High Pass Filter

HV		

High Voltage

i/o		

Input / Output

JFET		

Junction Field Effect Transistor

LED		

Light Emitting Diode

RoHS		

Restriction of Hazardous Substances

RAM		

Random Access Memory

S/PDIF

Sony Philips Digital Interface Format

THD+N

Total Harmonic Distortion + Noise

TRS		

Tip Ring Sleeve (1/4” Jack Balanced)

TS		

Tip Sleeve (1/4” Jack Unbalanced)

USB		

Universal Serial Bus

If your unit is in warranty, please contact your dealer directly for a repair or replacement (at the
discretion of the dealer).
For out of warranty repairs, please contact Audient Ltd, after which a Return Materials

Authorization (RMA) number will be assigned. This number will serve as a reference for you
and helps facilitate and expedite the return process. When the unit is returned please include this
RMA number along with a description of the fault inside the packaging box.

V		 Volts
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XLR		

Extra Live Return, Extremely Low Resistance, Canon X Series, Latching,

		

Resilient Rubber Compound... or make up your own!

57

